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Overview 

 

PT Tracker is designed for use by Precision Teaching practitioners.  It can track the progress of 

multiple students and can track each student's progress in one or more skills.  The program tracks 

and displays timings over a period of up to 210 consecutive days.  If more than 210 days are 

needed for a particular skill, you’ll need to start a new skill for the student. 

PT Tracker stores all the data for a given student (identified by a first name, last name and 

optional ID) in one file. The set of all such files is called the “PT Tracker database”.  Every time 

any data is changed for a student, the entire student file is automatically saved, so there is no 

need to click a button to save the file.  In fact, no such button exists. See Student File for more 

information about these files. 

Within this manual, there are frequent references to “student” and “skill”. However, within the 

program, you can change how these terms appear in menus, screens and charts. There are two 

ways to do this: 

• The Settings / Change nomenclature menu selection changes the majority of the 

instances of these two words within the program. 

 

• When defining a skill (for example, using the File / Add new skill menu selection), you 

can specify the “Chart Title”, which is the header that will precede the name of the skill 

at the top of the chart. If the Chart Title is blank, the skill name will not have a header 

and instead will be displayed in parentheses. 

  



Menus 

Some menu options can be accessed via keyboard shortcuts.  On PC’s, you hold down the Ctrl 

key and then press the specified letter.  On Macs, you hold down the Cmd key and then the letter.  

The keyboard actions are: 

Letter Menu Menu Item Description 

L File Load student Load a student’s data into PT Tracker. 

S File Select skill Display list of current student’s skills and select one. 

F File Next skill Display the student’s next skill alphabetically. 

B File Previous skill Display the student’s previous skill alphabetically. 

T Chart Edit timings Edit the timings of the currently displayed skill. 

P Chart Phase change Create a new phase change. 

C Chart Celeration line Create a new celeration line. 

A Chart Aim star Create a new aim star. 

 

File Menu 

The following selections are available from the File menu: 

• Load student: Presents a file selection window so that you can choose a student file to 

load into PT Tracker. 

 

• Add new student: Displays the New/edit Student screen to add a new student to the 

system (this will create a file for the new student). 

 

• Rename student: Displays the New/Edit Student screen so that you can change the first 

name, last name and/or ID of the currently displayed student. 

 

• Close student: Stops displaying whatever student is currently displayed. 

 

• Select skill: Changes the currently active skill. 

 

• Add new skill:  Displays the New/Edit Skill screen to add a new skill to the currently 

loaded student. 

 

• Edit skill: Displays the New/Edit Skill screen so that you can change the skill parameters 

(such as the skill name, the range of the y-axis, the number of days on the chart, etc.). 

 

• Set default skill: Allows you to choose a default skill from the current student's skill 

list.  The default skill will get displayed whenever a student's data is loaded into the 

program.  It will also be the pre-selected skill when you choose the Select skill option 

(above). 

 

• Next skill: Displays the chart for the current student’s next skill alphabetically.  This 

menu item makes it easy to quickly scan through all the charts of a particular student.  It 

can be performed using the keyboard shortcut Ctrl-F (for “forward”); Cmd-F on Macs. 

 



• Previous skill: Displays the chart of the current student’s previous skill alphabetically.  It 

can be performed using the keyboard shortcut Ctrl-B (for “back”); Cmd-B on Macs. 

Chart Menu 

The Chart menu lets you add new timings and annotations to the chart. You can also edit and 

delete timings and annotations you have already added.  The menu items on the Chart menu are: 

• Edit timings: Displays the Edit Timings screen, which displays all the timings for the 

currently selected skill. Allows you to add timings to the list, including for previous days. 

Also allows you to delete and modify timings from the list. 

 

• Phase change: Displays the New Phase Change screen for adding a new phase change. 

 

• Celeration line: Displays the New Celeration Line screen for adding a new celeration 

line. 

 

• Aim star: Displays the New Aim Star screen for adding a new aim star. 

 

• Edit annotations: Displays the Edit Annotations screen, which displays a list of 

annotations and lets you view, edit or delete specific annotations. 

Google Menu 

The Google menu is only displayed when Google mode was activated at startup of PT 

Tracker.  See the section Google Mode for information about the Google menu. 

Settings Menu 

When you change a setting via the Settings menu, PT Tracker automatically rewrites the settings 

file so that the updated setting will be the default the next time you start PT Tracker.  The menu 

items on the Settings menu are: 

• Change/save default database directory: Establishes a new directory for saving student 

files. 

 

• Change skill defaults: Brings up the New/Edit Skill screen so that you can edit/modify 

the defaults that are displayed whenever you make a new skill. 

 

• Use SCC aspect ratio: If this menu item is checked, PT Tracker will use the Standard 

Celeration Chart aspect ratio on all charts.  The SCC aspect ratio causes the x2 celeration 

line to have a 33-degree angle with respect to the horizontal axis. 

 

• Save current chart size: Use this option after resizing your chart to make it the new size 

the default size. 

 



• Logo options: Brings up the Edit Logo Display screen, which allows you to disable the 

logo or choose your own logo for displaying in the middle of the chart. 

 

• Change nomenclature: Brings up the Change Nomenclature screen.  Throughout this 

documentation and also in the program menus, error messages and dialog boxes, two key 

words are used: "student" and "skill".  If those words aren't appropriate for your situation, 

you can choose this menu option to select different words to use.  For example, you 

might prefer to use the word "client" instead of "student".  Note that, to change the word 

"Skill" that appears in the chart title, you need to change the "Chart Title" field in the 

New/Edit Skill screen. 

 

• Change Google Drive folder: By default, student files are not saved to Google 

Drive.  However, if you specify a Google Drive folder using this menu option, then the 

next time you start PT Tracker, it will attempt to save student files both to the local 

computer and to the Google Drive folder you specify.  Refer to the Google mode section 

for more information about automatically saving student files to Google Drive. 

 

• Chart appearance: Brings up the Chart Appearance screen, which allows you to change 

the color and shape of some of the items that are displayed on the chart. 

 

• Change output directory: Establishes a different directory into which PT Tracker output 

files will be written.  As of Version 5.1, the only output files are image files generated via 

the Save chart as .png option of the Tools menu. 

 

• Import: Brings up a submenu with these options for providing defaults used when 

performing an import: 

 

o Import file processing: Brings up the Import-File Processing Parameters screen, 

which contains defaults for how an import file will be chosen and processed. 

 

o Default student for imports: Brings up the New/Edit Student screen so that you 

can specify default values for the student identification (first name, last name and 

ID) to be associated with imported timings. 

 

o Default skill for imports: Brings up the New/Edit Skill screen so that you can 

specify default values for the skill to be associated with imported timings. 

 

o Defaults for saving to database: Brings up the Edit Defaults for Saving Imported 

Timings screen, which contains defaults regarding whether imported timings are 

saved to the PT Tracker database and whether imported timings replace existing 

timings if the imported student/skill already exists. 

 

o Export directory: Brings up a screen that allows you to pick the directory to 

which PT Tracker will write export files. 

Tools Menu 

The Tools menu has these options: 



• Import timings: Prompts you to pick a timings file to import. (See Appendix C for the 

format of the file.) Loads the import file into PT Tracker and then displays the Import-

File Post Processing Parameters screen. 

 

• Import timings – quick: Prompts you to pick a timings file to import. (See Appendix C 

for the format of the file.) Immediately displays the timings. If no error is encountered 

and the “save data” setting is Y, the imported timings will be saved to the PT Tracker 

database. 

o If any of the default student identification fields (first name, last name, ID) are 

blank and are not included in the import file either, dummy values will be 

provided. 

o If the default skill name field is blank and not included in the import file, a 

dummy skill name will be provided. 

 

• Export timings for current student: The currently displayed skill is exported. See 

Appendix D for more information about exporting. 

 

• Save chart as .png: Saves the current chart to a .png file in the output directory. 

 

• Reset window size: Resets the size of the PT Tracker main window to its original size as 

of when the program started up. 

 

• Remove extra window space: When you resize the program in "SCC aspect ratio" 

mode, typically there will be extra space in PT Tracker's main window.  You can remove 

the extra space using this menu option. 

 

• Celeration line diagnostics: Displays a list of all the celeration lines in the current skill.  

After you choose one, the Celeration Line Diagnostics screen will be displayed.  That 

screen displays many of the intermediate and final results of the celeration line 

calculation. 

 

• Display log: Displays a list of messages that may help the programmer diagnose 

problems with PT Tracker.  After there are 100 messages in the log, older messages are 

deleted as newer messages are added.  The log is erased when the program terminates.  

Pop-up Menu 

If you right-click on the chart on the main screen, a one-option menu will appear giving you the 

option to save the chart to a .png file. 

 

  



Screens 

In all the screens described below, except the Main screen, the Escape key on the keyboard 

performs the same action as the Cancel button.  That is, it exits the screen without saving any 

pending changes. 

Main Screen 

 

The main screen provides a graphical display of the timings and annotations that you enter.  The 

two top corners of the chart have the start year and end year of the current skill. 

On the main screen, you can add timings for the current date and skill.  Just fill in these three 

fields: 

• Duration: The duration of the timing.  When you first add a new skill for a student, you 

will specify whether timings are in minutes, hours, or one day.  The duration is in 

whatever units were specified. 

 

o Minute timings: Minute timings can always be specified as a decimal number.  

For example, a minute and 15 seconds can be entered as 1.25. For minute timings 

that are less than one hour, you can also enter them as M:SS, where M is one or 

two digits and SS is two digits.  For example, 1:15. 

 



o Hour timings: Duration is specified as H or H:MM, where H is one or two digits 

and MM is two digits.  For example, ten hours can be entered as “10” or “10:00”.  

Ten hours and 22 minutes would be entered as 10:22. 

 

o Day timings: “1” is the only allowable value for duration. 

 

• Count: The number of times the student correctly performed the requisite task during the 

specified duration. 

 

• NumErrors: The number of errors made by the student during the timing. 

After filling in those fields, add the new timing to the current skill by either pressing the Enter 

key on the keyboard or clicking the Add Timing button on the main screen. 

On the semi-log chart, timings are displayed this way where the x-value of the chart corresponds 

to the current date: 

• Record Floor: The inverse of the Duration (1/Duration) is called the “record floor”. A 

short horizontal line is displayed at the record floor.  For example, if the duration is five 

minutes, there will be a horizontal line at 0.2. 

 

• Count: Count is converted to count per time unit. It will appear as a filled circle 

calculated as Count/Duration.  For example, if Duration is two minutes and Count is 182, 

there will be a filled circle at 91.  If count is 0 (a “no-count”), it is displayed as a question 

mark (?) just under the record floor line. 

 

• NumErrors: NumErrors is converted to errors per time unit.  It will appear as a filled 

rectangle at NumErrors/Duration.  For example, if Duration is a half-minute and there are 

2 errors, there will be a rectangle at 4.  If NumErrors is zero, there will be a small, 

configurable mark (a dot by default) under the record floor line (but if Count is also 0, the 

NumErrors mark is not displayed). 

You can change the default colors of the record floor, count per time unit, errors per time unit, 

and no-count marks using the Chart appearance option of the Settings menu.  You can also 

change the shape of the count per time unit and errors per time unit marks using that option. 

 

New/Edit Student Screen 

 



The New/Edit Student screen contains three fields: 

• First Name: Required field (except when using this screen to edit import-file defaults). 

• Last Name: Required field (except when using this screen to edit import-file defaults). 

• ID: Optional field.  The user can decide its meaning.   For example, it could be used to 

distinguish two students with the same name, or two different files for the same student. 

New student: When you click Save while adding a new student to the system, you will 

immediately be prompted to create a skill for the new student.  After that, the new student's data 

will be automatically written to that student's file even if you click Cancel on the New Skill 

screen. 

Edit existing student: When you click Save while editing an existing student in the system, PT 

Tracker creates a new ptt file for the student; saves a copy of the old ptt file in the archive 

directory; and deletes the old ptt file. 

Edit import defaults: When you click Save while editing import defaults, the fields will be 

saved to settings file.  In this mode, all three fields are optional because they can be set when 

timings are imported. 

 

New/Edit Skill Screen 

 

The New/Edit Skill screen has these four uses: 

• Add a new skill for the currently loaded student (via the File Menu Add New Skill 

option). 

 

• Edit the currently selected skill of the currently loaded student (via the File Menu Edit 

Skill option). 

 

• Edit the skill defaults that appear whenever a new skill is created (via the Settings Menu 

Change skill defaults option). 

 

• Edit the skill defaults that are used when an import file is loaded (via the Tools Menu 

Import timings option or Import timings – quick option). 



The New/Edit Skill screen has these fields: 

• Skill name: An identifier for the skill (can be left blank when using this screen to edit 

import-file defaults). 

 

• Timing Units: Can be minutes, hours or days.  You can't change Timing Units after 

timings have been added to the skill. 

 

• Max Duration: This field is for error checking your timings.  PT Tracker will not allow 

you to enter a timing with a duration greater than Max Duration.  The format depends on 

what was specified for Timing Units, as follows: 

o Minutes: A decimal number.  For example, 40.5.  Max Durations that are under 

on hour can also be entered as M:SS (where M is a one- or two-digit number and 

SS is a two-digit number).  For example, 40:30. 

o Hours: Either H or H:MM (where H is a one- or two-digit number and MM is a 

two-digit number). 

o Days: Always 1 

 

• Y-Axis Min: The lowest value on the y-axis. 

 

• Y-Axis Max: The highest value on the y-axis. 

 

• Days in Chart: The number of days displayed on the chart.  You can choose a number 

from 70 to 210.  It must be a multiple of 7. 

 

• Chart Title: This description will appear before the skill name on the chart.  If you leave 

this field blank, the skill name will simply be displayed in parentheses. 

When editing a skill: 

▪ You cannot decrease Max Duration if some of the existing timings exceed the new 

duration. 

 

▪ You can't increase Y-Axis Min if there is currently viewable data that would no longer be 

displayed on the chart with the new Y-Axis Min. 

 

▪ You can't decrease Y-Axis Max if there is currently viewable data that would no longer 

be displayed on the chart with the new Y-Axis Max. 

 

▪ You can't decrease Days in Chart if there is currently viewable data that would no longer 

be displayed on the chart with the new value of Days in Chart. 

When editing skill defaults for import files, you can leave Skill Name blank because it can be 

specified in import files. 

 

 



Edit Timings Screen 

 

The Edit Timings screen has three purposes: 

• Display all timings for the current skill. 

• Add new timings for the current or a prior date. 

• Delete or modify timings. 

To add a timing on the Edit Timings screen, just fill in the four fields (Date, Duration, Count and 

NumErrors) and press the Enter key or click the Add Timing button.  The Duration field will be 

labeled Minutes, Hours or Days, depending on what was chosen for the Timing Unit when you 

set up the skill. 

To delete or modify a timing on the Edit Timings screen, right-click on the timing you want to 

delete or modify.  This will display the following menu: 

• View: Displays the timing, along with the day number, count per time unit, errors per 

time unit, and record floor. 

• Edit: Displays the Edit or Delete Timing screen 

• Delete: Prompts you to confirm and deletes the timing if you confirm. 

• Exit: Exits the Edit Timings screen. 

You can double-click on the timing you want to delete or modify and the Edit or Delete Timing 

screen will be displayed. 

A time stamp is associated with every timing.  The time stamp is always chosen automatically by 

the PT Tracker program; it is not possible for the user to choose it.  It is always set to the time of 

day at which the timing was added to PT Tracker, which is not necessarily the time of day at 



which the timing was performed.  If you use the Edit or Delete Timing screen to modify the date 

of a timing, its time stamp will be changed to the time at which the modification was performed. 

Every timing also has an associated day number (DayNo).  The day number is also determined 

automatically by PT Tracker.  Day zero, which is never used, is always the Sunday before the 

first timing or annotation (i.e., phase change, celeration line, or aim star). 

 

Edit or Delete Timing Screen 

 

The Edit or Delete Timing screen displays these fields of the selected timing so that you can edit 

them. 

• Date: The date the timing was done.  Format: MM/DD/YY or MM/DD/YYYY 

• Duration: In the same units specified in the Timing Units field of the New/Edit Skill 

screen.  Cannot be greater than the Max Duration specified for its skill. 

• Count: A number greater than or equal to 0.  If Count is zero, a question mark (?) will be 

displayed just under the record floor line. 

• NumErrors: A number greater than or equal to 0.  If NumErrors is zero, it will be 

displayed as a dot just under the record floor line (unless Count is also zero). 

The Edit or Delete Timing screen has three buttons: 

• Save Timing: Saves the changes made to the timing. 

• Delete Timing: Deletes the timing. 

• Cancel: Returns to the Edit Timings screen without changing the timing.  The Cancel 

button is the default, so if you just click Enter on the keyboard, you'll cancel the Edit or 

Delete Timing screen without either saving or deleting the timing. 

 

New/Edit Phase Change Screen 

You display the New Phase Change screen via the Phase change option on the Chart menu.  

You display the Edit Phase Change screen via the Edit Annotations screen. 



 

The New/Edit Phase Change screen lets you create or edit a phase change annotation on the 

chart.  A phase change appears, on a particular date, as a vertical line with a comment at the top 

of the line.  The line can start and end at the y-values you specify.  The fields are: 

• Comment: The text that appears at the top of the phase change line. 

• Date: The date on which the phase change line will appear. Format: mm/dd/yy 

• Y1: The lowest y-value of the line. 

• Y2: The highest y-value of the line. 

By default, the phase change line is red, but you can change its color using the Chart appearance 

option of the Settings menu. 

 

New/Edit Celeration Line Screen 

You display the New Celeration Line screen via the Celeration Line option on the Chart menu.  

You display the Edit Celeration Line screen via the Edit Annotations screen. 

 

The New/Edit Celeration Line screen lets you create or modify a celeration line annotation on the 

chart.  A celeration line appears on the chart as a solid line that represents a student’s progress 

over multiple timings.  You can also specify the display of a dashed line representing a 

projection of the celeration line into the future. 



Every celeration line has a text label that identifies the celeration and the method used to 

calculate it.  The calculation methods are abbreviated as follows: 

• Th-Se: Theil-Sen 

• Reg: OLS regression 

• Sp-Mid: Split-Middle 

• Qtr-Int: Quarter-Intersect 

The fields of the New/Edit Celeration Line screen are: 

• Start Date: The celeration line will be calculated using timings that appear on or after 

this date.  Format: mm/dd/yy 

• End Date: The celeration will be calculated using timings that appear on or before this 

date.  Format: mm/dd/yy 

• Projection Date: The celeration line will continue from the End Date to the Projection 

Date as a dashed line.  If you don’t want a projection line, just set Projection Date to the 

same date as End Date.  Timings in the domain of the dashed line are not included in the 

celeration line calculation.  Format: mm/dd/yy 

• Label Placement: There are two options: 

o Default: PT Tracker will choose where to put the label that displays the celeration. 

o User point: You can choose the date and y-value of the right-most edge of the 

label.  This can be handy if PT Tracker doesn’t choose a good default location. 

• Label Date: If you select “User point” for Label Placement, this is the date on which the 

label will end.  Format: mm/dd/yy 

• Label Y: If you select “User point” for Label Placement, this is the y-value at which the 

label will be placed. 

• Which Data: There are three options: 

o Count: Only display the celeration line for Count data. 

o Errors: Only display the celeration line for NumErrors data. 

o Count and Errors: Display the celeration lines for both Count and NumErrors 

data.  In this case, if you choose “User point” for Label Placement, the specified 

placement will only be used for the Count celeration line.  Default placement will 

be used for the NumErrors celeration line. 

• Calc Method: There are four options.  The four calculation methods are discussed in 

detail in Appendix A, Celeration Line Calculation Methods.  The four options are: 

o Theil-Sen 

o Regression 

o Split-Middle 

o Quarter-Intersect 

By default, the celeration line is black and the projection line is gray, but you can change these 

colors using the Chart appearance option of the Settings menu. 

 

 

 



New/Edit Aim Star Screen 

You display the New Aim Star screen via the Aim Star option on the Chart menu.  You display 

the Edit Aim Star screen via the Edit Annotations screen. 

 

The New/Edit Aim Star screen lets you create or modify an aim star annotation on the chart.  An 

aim star appears as an up or down arrow with a line through it to indicate the goal.  The screen 

fields are: 

• Date: The date on which the aim star is displayed.  Format: mm/dd/yy 

• Goal: The y-value at which the horizontal line in the aim star is drawn. 

• Direction: Up or Down – the direction that the arrow should point. 

By default, the aim star is black, but you can change its color using the Chart appearance option 

of the Settings menu. 

 

Edit Annotations Screen 

You display the Edit Annotations screen via the Edit annotations option on the Chart menu. 

 



The Edit Annotations screen lets you view, edit, and delete existing annotations.  When you 

right-click on an annotation, the following menu will be displayed: 

• View: View the parameters of the selected annotation. 

• Edit: Edit the parameters of the selected annotation.  This option will bring up the 

appropriate dialog box.  For example, the Edit Phase Change screen for phase change 

annotations. 

• Delete: Prompts you to confirm the deletion and then deletes the specified annotation. 

• Exit: Exits the Edit Annotations screen. 

You can also edit the parameters of an annotation by double-clicking on it. 

 

Edit Logo Display Screen 

 

The Edit Logo Display screen allows you to change the logo that is displayed in the middle of the 

chart.  The screen has these user inputs: 

• Logo Display Type: This option determines what logo will be displayed in the middle of 

the chart on PT Tracker's main window.  Options include: 

o Loco4Learning: Display the Loco4Learning LLC logo. 

o None: Don't display any logo. 

o User: Display a user-selected logo. 

• Opacity: This number from 0 to 1 controls how dark the logo will be.  If the value is 0, 

the logo will be invisible.  If the value is 1, the logo will have the full opacity of the logo 

image. 

• Pick Logo: Use this button to choose the logo to be displayed if the Logo Display Type 

is “User”. 

 

 

 

 

 



Edit Nomenclature Screen 

 

The Edit Nomenclature screen lets you change the words "student" and "skill" to something 

more appropriate for your use.  The words "student" and "skill" appear repeatedly in this 

documentation, in the menus, in the error messages and in the dialog boxes.  You can change 

those two words to something that makes more sense to you if you'd like.  The Edit 

Nomenclature screen has these six fields: 

• Client 

o Singular/NoCap: The singular form of the word that will replace "student" (not 

capitalized) 

o Singular/Cap: The singular form of the word that will replace "Student" 

(capitalized) 

o Plural/NoCap: The plural form of the word that will replace "students" (not 

capitalized) 

• Skill 

o Singular/NoCap: The singular form of the word that will replace "skill" (not 

capitalized) 

o Singular/Cap: The singular form of the word that will replace "Skill" (capitalized) 

o Plural/NoCap: The plural form of the word that will replace "skills" (not 

capitalized) 

After changing the nomenclature, PT Tracker menus, dialog boxes, feedback and error messages 

will use the newly specified words. 

Note that whatever you specify as "Client-Singular/Cap" will appear in the title of the chart in PT 

Tracker's main window.  However, to replace the word "Skill:" on the chart, you need to change 

the "Chart Title" field of the New/Edit Skill screen. 

 

Chart Appearance Screen 

You display the Chart Appearance screen via the Chart appearance option on the Settings 

menu. 



 

The Chart Appearance screen lets you customize the appearance of various items on the chart.  

The four buttons at the bottom of the screen have these effects: 

• Save: Saves any changes to the Settings file, updates the chart, and exits the Chart 

Appearance screen. 

• Update: Saves any changes to the Settings file and updates the chart but does NOT exit 

the Chart Appearance screen. 

• Reset: Resets all the chart appearance parameters to their default settings (shown in the 

image above), saves the changes to the Settings file, and updates the chart.  (You will be 

prompted to confirm before any of these changes take effect.)  Does NOT exit the Chart 

Appearance screen.   

• Cancel: Cancels any changes that haven’t been written to the Settings file and exits the 

Chart Appearance screen. 

The items on the screen are: 

• Count: Click this button to change the color of the “count per time unit” marks on the 

chart. 

• Mark Type (Count): Select the shape of the “count per time unit” marks on the chart: 

circle, square, X, or dot. 

• Errors: Button to change color of “errors per time unit” marks. 

• Mark Type (Errors): For changing the shape of the “errors per time unit” marks. 

• No Count: Button to change the color of the question marks that represents a no-count 

timing. 

• No Errors: Button to change the color of the mark used to indicate that no errors were 

reported for a particular timing. 

• Mark Type (No Errors): For changing the “No Errors” shape.  When no errors are 

reported for a timing, this mark will appear just under the record floor line (except that 

when a question mark appears there, the No Errors mark isn’t displayed).  



• Record Floor: Button to change the color of record floor lines. 

• Aim Star: Button to change the color of aim stars. 

• Phase Change: Button to change the color of phase change lines. 

• Celeration Line: Button to change the color of celeration lines. 

• Projection Line: Button to change the color of the dashed lines that project celeration 

lines into the future. 

• Chart Color: This is the color used for the chart title, chart outline, grid lines, tick labels, 

and axis labels. 

• Code: You can choose one of the following three options.  If you choose “Original” or 

“SCC”, the Chart Color button is disabled. 

o Original: The chart color will be the same as in the original version of PT 

Tracker. 

o SCC: The chart color will approximate that of a traditional Standard Celeration 

Chart. 

o User: The Chart Color button will be enabled and you can choose the chart color. 

 

Import-File Processing Parameters Screen 

You display the Import-File Processing Parameters screen via the Settings/Import/Import file 

processing menu selection. 

  

This screen lets you set defaults for several aspects of reading import files.  The items on the 

screen include: 

• Directory: Click the Directory button to display a window for selecting the default 

directory for import files. 

 

• R: This button removes the currently selected default import directory. When no default 

import directory is specified, PT Tracker will look for import files in the database 

directory (i.e., the same place that PT Tracker keeps student files). 

 

• Timing Fields: This text box contains a comma-delimited default list of timing record 

fields. You can use this list to tell PT Tracker the fields that every timing record must 

contain. You can override this default by including the #FIELDS control record in the 

import file. The format and meaning of this list is the same as that of the #FIELDS 



control record. 

 

• Date Format: Use this item to select the default format for dates found in timing records. 

The list box contains a list of all available date formats. You can override this default by 

using the #DATE_FORMAT control record in the import file. 

 

• Sort Timings: Sets the default for whether PT Tracker chronologically sorts the timing 

records after reading them in. If your import file is supposed to be pre-sorted 

chronologically, it is recommended that you set this to “No”. That way, PT Tracker will 

give you an error message if the records aren’t sorted correctly, as that could indicate data 

corruption in your import file. You can override this default by using the #SORT control 

record in the import file. 

 

• Save: Saves the current values of the screen and writes the Settings file. 

 

• Cancel: Cancels the screen without saving. 

 

Edit Defaults for Saving Imported Timings Screen 

You display the Edit Defaults for Saving Imported Timings screen via the 

Settings/Import/Defaults for saving to database menu selection. 

 

This screen lets you set defaults for how imported timings are saved. These defaults can be 

overridden in the import file. The items on the screen include: 

• Save imported data to PT Tracker Database: 

 

o Checked: Newly imported timings will be saved to the PT Tracker database. If the 

imported student doesn’t exist in the database, it will be created. If it does exist, 

the imported timings will be added to the existing student.  

 

o Not checked: The imported timings will be displayed but they won’t be saved to 

the database. 

 

• Replace all existing timings in specified skill: This setting only takes effect if the 

specified student already exists in the PT Tracker database (or is displayed) AND the 

imported skill matches an existing skill of the specified student. 

 



o Checked: All existing timings in the skill will be deleted and the newly imported 

timings will replace them. 

 

o Not checked: All existing timings will remain. The newly imported timings will 

be added to the existing ones. 

The buttons at the bottom of the screen are: 

• Save: Saves the selections to the settings file. 

• Cancel: Exits the screen without saving. 

 

Import-File Post Processing Parameters Screen 

The Import-File Post Processing Parameters screen is displayed after selecting a file to import 

via the Tools/Import Timings menu selection. 

 

This screen gives you one last chance to change certain parameters of the imported data prior to 

displaying the imported timings and (optionally) saving the timings to the PT Tracker database. 

The fields of this screen are initialized based on the control records found in the import file. 

However, if the import file does not have the control record that corresponds to a particular field 



on this screen, the field is populated via defaults (which can be changed via the Settings / Import 

submenu). 

The items on this screen include: 

• Student: This portion of the screen has the same fields, with the same meanings, as the 

New/Edit Student screen. 

 

• Skill: This portion of the screen has the same fields, with the same meanings, as the 

New/Edit Skill screen. You cannot change the Timing Units field because the imported 

timings were validated based on the Timing Units used at the time of reading the file. 

 

• Database Save Options: This portion of the screen has the same fields, with the same 

meanings, as the Edit Defaults for Saving Imported Timings screen. 

 

Note that, if not saving to the database, you will still be able to add/delete timings, 

add/delete annotations and even add new skills. However, none of that will be saved to 

the database. 

 

Also, if the imported data is not saved to the database and the imported student already 

exists with other skills, those skills will not be visible until you use the File / Close menu 

to close the student and reload it from the database. 

 

• Finish: Displays the imported timings. Saves the timings to the PT Tracker database if 

that option was selected. 

 

• Show Timings: Displays a screen that shows the values of the imported timing fields, as 

well as the contents of each imported timing record. 

 

• Cancel: Cancels the import. The imported timings are not displayed, and the PT Tracker 

database is not updated. 

  



Files & Directories 

PT Tracker Database 

The phrase “PT Tracker database” refers to the set of student files maintained in an internal 

format and following the naming convention described in the in the section Student File below. 

Those files can be anywhere in the computer’s file system, but they would typically be found in 

the database directory (described below). Import and export files are NOT part of the PT Tracker 

database. 

Student Files 

PT Tracker stores all the data for a given student in one file. The collection of all such files is 

called the “PT Tracker database”.  Every time any data is changed for a student, the entire file is 

automatically saved.  The following information is saved in a student file: 

• First name 

• Last name 

• ID: The ID field is optional, and the user can decide its use and meaning.  For example, it 

could be used to distinguish two students with the same name, or two different files for 

the same student. 

• Skill(s): Each skill has its own name that you provide.  You can also specify: the time 

units for measurements (minutes, hours, days); the range of the y-axis; the number of 

days of data to collect (up to 210); and other parameters. 

• Timing(s): Each timing is associated with a skill and contains the timing date, duration, 

count and the number of errors. 

• Annotation(s): Each skill can have zero or more annotations (phase changes, celeration 

lines, aim stars) associated with it. 

• Default skill: This identifies the skill displayed when you load the data for a student. 

The data for a student is stored in a file with this file naming convention: 

FirstName_LastName_ID.ptt 

For example, the data for student Jane Doe, whose ID is "23", will be stored in a file named 

Jane_Doe_23.ptt.  The data for student John Doe, who hasn't been assigned an ID, will be 

stored in a file called John_Doe_.ptt. 

Annotations (phase changes, celeration lines, and aim stars) are stored in the student file with the 

associated skill.  Whenever an annotation is added, modified, or deleted, the student file is 

automatically updated.  There is no need to save the file (in fact, there is no manual way to do 

so!). 

Database Directory 

PT Tracker saves student data in files that have the .ptt file extension in the database 

directory.  When you first install PT Tracker, the location of the student data files is set as 

follows: 



• Windows: The "Start in" directory, which is typically the directory where PT Tracker is. 

• Mac OS: The user's Documents directory. 

It is likely that neither of these default locations are desirable for your particular use.  If that is 

the case, on your first use of PT Tracker, you should use the Change/Save default database 

directory option of the Settings menu to change the database directory to be its own dedicated 

location. 

Settings File 

Usually, you will never have any need to look at the settings file.  PT Tracker automatically 

creates, reads, and writes it as follows:  

• On startup, PT Tracker creates a new settings file if the file doesn't exist where it is 

supposed to be.  It fills the file with "factory defaults".  

• If the settings file exists on startup, PT Tracker reads it and uses its contents as defaults 

during the session.  

• Whenever you change a setting via the Settings menu, PT Tracker rewrites the settings 

file. 

The location of the settings file depends on the operating system, as follows:  

• Windows: PT Tracker puts and looks for the settings file in the first of the following 

directories found to exist: 

 

o $HOME\Documents: where $HOME is the user’s home directory, typically 

$HOME is c:\Users\username\Documents. 

 

o $APPDATA: the user’s application data directory assigned by Windows, typically 

the hidden directory C:\Users\username\AppData\Roaming\com.loco4learning.PT 

Tracker. 

 

o $HOME: the user’s home directory. 

 

• MacOS: The settings file is in the user’s Library/Preferences directory. 

The name of the settings file also depends on the operating system, as follows:  

• Windows: .pt-tracker.txt  

• MacOS: com.loco4learning.PT-Tracker.txt  

Auto-archive 

Every time PT Tracker saves a student file, it also creates an archived version of it.  The archived 

versions are saved in a subdirectory of the database directory called archive.  Every archived file 

has the archive date in its name so that the last version saved on any given day will be available 

on subsequent days.  After three weeks, archive files are automatically deleted.  There is 



currently no automated way to recover archived data, but it can be done manually using the 

operating system's file management commands.  Here are the general steps to follow: 

• If the invalid student file still exists in the database directory, rename or delete it. 

• Copy the appropriate archive file to the database directory. 

• Rename the copied archive file, removing the hyphen and the date after the hyphen. 

For example, let's say something bad happens to the student file John_Smith_.ptt.  Delete it or 

rename it.  Then copy an appropriate archive file to the database directory.  For example, you 

might want to restore the data from October 29, 2021, so you would copy the file called 

John_Smith_-2021-10-29.ptt.  Then rename that file to be John_Smith_.ptt. 

Output Directory 

The output directory is a local directory into which PT Tracker will write output files.  As of 

Version 5.1, the only files written there are image files.  There are two ways to write image files: 

• By selecting the Save chart as .png menu option of the Tools menu. 

• By right-clicking on the chart and selecting Save as on the popup menu. 

By default, the output directory is the same as the database directory.  You can change this 

location using the Change output directory option of the Settings menu. 

Import Files 

An import file is a user-created CSV file containing timings that can be imported into PT 

Tracker. The format of the file is described in detail in Appendix C. 

Import Directory 

The import directory is the directory in which PT Tracker will initially look for import files. The 

first time you use PT Tracker, the import directory will be the same as the database directory. It 

is highly recommended that you use the Settings/Import/Import file processing menu item to 

change the default import directory so that import files are not stored in the same place as student 

files. 

Export Files 

Export files have the exact same format as import files. They are created in the export directory 

when you use the Tools/Export Timings for current student menu item. Appendix D has more 

information about export files. 

Export Directory 

The export directory is the directory into which PT Tracker will write export files. The first time 

you use PT Tracker, it will be the same as the database directory. It is highly recommended that 

you use the Settings/Import/Export Directory menu item to change the default export directory, 

as it is bad practice to have export files in the same directory as student files. 



Google Mode 

Overview  

To support teachers who teach their students from different computers – perhaps one at home 

and one at work – PT Tracker offers the capability to automatically save student files to Google 

Drive whenever they are updated on the local machine.  Then, when the teacher needs to access a 

file saved from a different computer, the student file can be downloaded from Google Drive 

using the Download student file menu option on the Google menu. 

PT Tracker's use of Google Drive is designed to protect all the other files you have placed on 

Google Drive.  See Data Privacy/Security and File Sharing with other Users for a description of 

how PT Tracker protects your other files. 

"Google mode" is disabled by default.  To enable Google mode, you need to select the Change 

Google Drive folder option of the Settings Menu.  There, you will specify the Google folder ID 

of the Google folder where you want to save your student files.  After specifying the folder ID, 

you must exit PT Tracker and start it again.  See Configuring the Google Drive Folder ID for 

instructions on obtaining the folder ID. 

Google Mode User Interface  

Auto-save of Student Files  

Recall that PT Tracker automatically saves a student file to the local computer every time student 

data is changed.  When in Google mode, whenever PT Tracker successfully saves a student file 

to the local drive, it also automatically uploads a copy of the file to Google Drive.  If for some 

reason, PT Tracker is unable to upload a copy of the file, it will display an error message and put 

the data in a queue to be uploaded later, if the problem can be fixed.  NOTE: The queue is erased 

when PT Tracker terminates.  

Specifying Google Account and Permissions  

The first time you start up PT Tracker in Google mode, Google will use your default web 

browser to prompt you to:  

• Specify a Google account that PT Tracker will use.  

• Give PT Tracker permission to "View and manage Google Drive files and folders that 

you have opened or created with this app."  

After the first use, PT Tracker and Google will typically remember your selections and it usually 

won't be necessary to specify them again on subsequent uses of PT Tracker.  However, if you 

wish to change them, you can use the Return to Google sign-in screen option of the Google 

Menu to repeat the sign-in and permissioning sequence. 

 

 



Google Menu  

In addition to automatic uploads to Google Drive, the following options are available on the 

Google menu when in Google mode:  

• Download student file: Displays a list of all the student files in the Google Drive 

Folder.  You will have the option of downloading one of those student files.  If there is a 

file by the same name in the currently active database directory of the local computer, the 

downloaded file will replace it.  After the file is downloaded to the local computer, the 

downloaded student data will be displayed. 

• Upload student file: Displays all the student files in the currently selected local database 

directory.  You will have the option of uploading one of those files to the Google Drive 

Folder.  As with automatic uploads, if an error occurs while uploading the file, an error 

message will be displayed and the data will be placed in a queue for later uploading if the 

problem can be fixed. 

• Return to Google sign-in screen: Allows you to re-specify the Google account you want 

PT Tracker to use.  In your default browser, Google will also ask you again whether you 

want to give PT Tracker permission to save and read Google Drive files (as described 

above in the section Specifying Google Account and Permissions). 

• Cancel attempt to sign-in to Google: Usually, when PT Tracker accesses Google Drive, 

the operations are relatively quick.  However, the sign-in process depends on user input, 

and so it can take a long time, or the user can make a mistake and cause PT Tracker to 

wait forever for a user response.  When this happens, you can use the Cancel attempt to 

sign-in to Google menu option to terminate the sign-in process. 

• Disable/Enable Google interface: This menu item disables Google functions.  When the 

Google interface is disabled:  

o You won't be able to use other Google menu items until you re-enable the Google 

interface.  

o Any time PT Tracker automatically saves a file to the local computer, it will add 

the data to the queue for later uploading to Google.  Again, remember that the 

queue gets erased when PT Tracker terminates, so if there is anything in the queue 

on termination, it will not have been saved to Google Drive.  

Google Status Display 

In Google mode, the status of the Google interface is always displayed in the lower right-hand 

corner of PT Tracker.  The status consists of a filled in circle whose color indicates the current 

status.  Possibilities include:  

• Green: PT Tracker successfully connected to Google.  Student file uploads (both 

automatic and requested) and downloads should succeed.  

• Yellow: Google sign-in is in progress.  You need to respond to the Google authorization 

request in your default browser.  

• Orange: A Google Drive operation (other than sign-in) is in progress.  These operations 

usually finish quickly unless there is an internet glitch.  These operations include:  

o Uploading a student file  

o Downloading a student file  

o Verifying that the Google Drive Folder is valid for saving files.  This operation is 

performed automatically at start-up, after signing in again, and whenever a new 



Google Drive Folder ID is specified (via the Change Google Drive folder menu 

option of the Settings menu).  

• Red: PT Tracker did not successfully connect to Google.  No file uploads or downloads 

can be performed. Auto-saves to Google Drive will be queued.  You will need to use the 

Return to Google sign-in screen option on the Google Menu to make the status turn 

green.  

• Gray: Google interface disabled.  Auto-saves to Google Drive will be queued.  You will 

need to re-enable the interface via the Enable Google interface menu option in order to 

resume uploading and downloading student files. 

 

Save Queue  

In Google mode, if for some reason PT Tracker is unable to upload a student file to Google 

Drive when required, a copy of the file is added to an internal "save queue" so that it can be 

uploaded as soon as possible.  PT Tracker attempts to upload the data in the save queue 

whenever any Google Drive operation is successfully completed.  This means that the queued 

student data will be uploaded after a successful sign-in to Google on behalf of PT Tracker. 

Whenever there are items in the save queue, an ugly yellow button will be displayed in the lower 

right-hand corner of PT Tracker.  This ugly button serves as a warning that data has not been 



uploaded.  If you click on the button, a list of the queued student files will be displayed.  When 

this list is displayed, if PT Tracker believes that it might be possible to successfully upload the 

files, it will also offer an option to attempt an upload of the queued data.  

The save queue is lost when PT Tracker terminates, so any student files that are in the queue 

when PT Tracker terminates will not get uploaded to Google Drive.  

Configuring the Google Drive Folder ID 

Every Google Drive file and folder has a unique ID that never changes throughout the life of the 

folder or file.  You can rename the file, move it to another folder, or delete it; it will still have the 

same ID until it completely disappears from Google’s system.  To use PT Tracker’s Google 

mode, you need to obtain the unique folder ID of the Google Drive folder where you want to put 

your student files. 

To get the folder ID and enable Google mode in PT Tracker, perform the following steps:  

• Create a Google Drive folder to hold the PT Tracker files.  

• Obtain the Google Drive file ID of the folder.  You can do this as follows:  

o Sign in to Google Drive.  

o Find the folder you created for PT Tracker files.  

o Right-click on the folder name to display a Google menu.  

o Select the Get Link menu item.  

o Google will display a link that looks something like this:  

▪ https://drive.google.com/drive/folders/1DQ3zj9axvaof5w1ZAeMLzym5X

RLxkGaC?usp=sharing  

o The file ID is everything between the last forward slash and the question mark.  

▪ In this example, it would be: 

1DQ3zj9axvaof5w1ZAeMLzym5XRLxkGaC  

o Copy the file ID of the folder (but not all the other stuff in the link).  

• Start PT Tracker  

o Go to the Settings menu and choose Change Google Drive folder.  

o In the dialog box, paste in the file ID.  

o Exit PT Tracker and restart.  

Data Privacy/Security and File Sharing with other Users  

PT Tracker uses a special Google Drive access permission that ensures the safety and privacy of 

all the user's other Google Drive files.  Before PT Tracker can access your files on Google Drive, 

Google opens a tab in your default browser and asks you: 

1) What Google account do you want to use for PT Tracker’s access to Google Drive, and 

2)  Do you want to give PT Tracker permission to "View and manage Google Drive files 

and folders that you have opened or created with this app." 

Here are some things to know about this mode for accessing Google Drive: 

• By using this mode, PT Tracker will not be able to access files that it didn't create. 

 



o There is one exception: PT Tracker will be able to create, modify and delete its 

own .ptt files in the Google Drive folder you specify using the procedure in 

section Configuring the Google Drive Folder ID. 

 

• PT Tracker can only read or overwrite files created while signed in to Google with the 

same account that created those files.  PT Tracker won't even be able to see/read files 

created via another Google account, even if they are in the same directory and even if 

they were created by PT Tracker. 

 

• PT Tracker can access a shared Google Drive folder if the specified Google account has 

Editor privileges on the folder.  However, again, if different Google accounts put files 

into a shared folder, PT Tracker will only be able to see/read the files created under the 

same account that wrote them.  

A user of PT Tracker can be confident that the program will not be able to read or write any 

Google Drive files but its own and the folder you specify.  This restriction is enforced by 

Google, not by PT Tracker. 

Sharing Google Drive Student Files with other Users 

All the privacy restrictions can make it problematic to share student files with another Google 

Drive user.  If other people need to use PT Tracker to access the same student files on Google 

Drive, everyone needs to use the same Google login.  In that case, I suggest that you create a new 

Google account specifically for when people use PT Tracker.  They would then sign in to that 

account when PT Tracker starts up and Google asks for your permission to let PT Tracker access 

Google Drive.  

Alternative to Google Mode 

The purpose behind Google Mode is to write student files to the cloud so that they can be 

accessed from anywhere.  There are probably other ways to accomplish this, although I haven’t 

personally tested them. 

There is software available that can make cloud files and folders appear as if they are on the local 

computer.  I believe Dropbox and Google both offer software to do this.  You would then set the 

Database Directory to be a cloud-based folder established by one of these vendors. 

One disadvantage of this type of solution is that if you lose your internet connection, you will 

also lose your ability to look at and update the student data.  (Some vendors may also have a 

solution for that too, by maintaining both local and cloud versions of the files.) 

  



Appendix A 

Celeration Line Calculation Methods 

PT Tracker offers four different algorithms for calculating celeration lines.  They are: 

• Theil-Sen 

• OLS regression 

• Split-middle 

• Quarter-intersect 

According to Koenig (1972), Koenig and Ogden Lindsley developed the quarter-intersect 

method.  It is also documented in Pennypacker, Gutierrez, and Lindsley (2003).  I believe the 

intention was to create a deterministic algorithm that could be easily performed so that precision 

teaching practitioners could confidently create celeration lines without needing to do numerous 

arithmetic calculations.  In my opinion, computers have made this method obsolete, but I have 

still included it in PT Tracker because of its traditional association with precision teaching. 

I don’t have the original split-middle paper by O. R. White, 1974, The split middle: A quickie 

method of trend estimation, but White and Haring (1980) describes the method.  Another 

description can be found in Datchuk and Kubina (2011).  The split-middle algorithm retains the 

advantage of not requiring arithmetic calculations and fixes some of quarter-intersect’s problems.  

However, it still has some deficiencies. 

OLS regression is a common approach across many fields for estimating the relation between 

two variables and is quite readily calculated by computers.  Some precision teaching 

practitioners have criticized it because it assigns a relatively large weight to outliers. 

Theil-Sen, suggested to me by Stuart Harder and described in Sen (1968), is another approach 

for estimating the linear relation between two variables and is also quite readily calculated by 

computers.  To my knowledge, it is not traditionally used by most precision teaching 

practitioners, but since it doesn’t overweight outliers, it appears to answer the concerns they have 

with OLS regression.  For that reason, it is the default calculation method in PT Tracker. 

Note: All celeration line calculations are performed in log space.  That, of course, presents a 

problem when either the count or the number of errors is zero because log10(0.0) is undefined.  

Omitting such observations from the calculation cannot be correct because they provide very 

important information about the learner’s progress.  There is no good solution, but PT Tracker 

resolves the problem by dividing the record floor by two and taking the log10 of the result.  In 

other words: 

 Yinput to calculation = log10(0.5 / duration) 

The following sections document the four methods. 

 

 



Theil-Sen 

You can find more about Theil-Sen on Wikipedia and here is another link with useful 

information: 

https://blogs.sas.com/content/iml/2019/05/28/theil-sen-robust-regression.html 

The Theil-Sen algorithm works like this: 

1. Find the slope between every pair of observations, except that no slopes are calculated 

between observations that are on the same day as each other. 

2. The median slope of all the slopes calculated in Step #1 defines the celeration.  (If there 

are an even number of slopes, the average of the two middle slopes defines the 

celeration.) 

3. The y-intercept is calculated by using the median slope (from step #2).  Using that slope, 

a line is projected back to the y-axis for every observation (obviously, these will all be 

parallel lines).  The median of these y-intercepts is the y-intercept of the celeration line.  

(If there are an even number of observations, the y-intercept of the celeration line is the 

average of the two middle y-intercepts.) 

Because of step #3, there will be an equal number of observations above the celeration line as 

below it.  (In some cases it is impossible to equalize them, but, in all cases, the number of 

observations on either side of the celeration line will be equalized to the maximum extent 

possible for the calculated slope.) 

OLS Regression 

In PT Tracker, ordinary least squares regression generates the same line as is obtained by asking 

Microsoft Excel to put a linear trend line on a scatter chart. 

Split-Middle 

The split-middle celeration line is calculated as follows: 

1. The observations are divided into two sets of points, each with the same number of 

points.  The first set has all the points closest to the start date and the second set has all 

the points closest to the end date. 

a. If there is an odd number of observations, the middle observation is NOT put into 

either set. 

2. In each set, the median date is determined. 

3. In each set, the median y-value is determined. 

4. Putting each set’s median date and median y-value together forms a kind of “median 

point” for each set. 

5. The celeration is defined by the slope of the line that passes through the two “median 

points”. 

6. The intercept is determined by using the slope from step #5 and finding the celeration 

line that results in an equal number of points being above the line as below it.  (PT 

Tracker does this by using the method described above in Step #3 of Theil-Sen.) 

https://blogs.sas.com/content/iml/2019/05/28/theil-sen-robust-regression.html


The split-middle algorithm has these deficiencies: 

• I couldn’t find a published description of what to do when there are multiple observations 

on one date (although such a publication might exist).  For that reason, I implemented my 

own solution, which was: 

o In step # 1, for all points on a given date, find the median y-value and treat that 

date as if it had just one point when calculating the celeration. 

o In step #6, treat all observations separately, even if some fall on the same dates as 

others. 

• If there is an odd number of dates, the middle date is ignored when calculating the 

celeration.  It is not good to ignore data!  In split-middle, that ignored point has no impact 

on the celeration calculation, but in Theil-Sen and OLS regression, the middle point can 

definitely impact the celeration calculation. 

• I couldn’t find a published description of whether to include any ignored middle point in 

step #6 of the split-middle algorithm.  I included it. 

Some might argue with the choices I made, and that’s fine.  If the precision teaching community 

reaches a consensus on how to handle these situations, I’ll implement the consensus method.  

However, I don’t think it’s worth the time to try to reach that consensus, as I believe that either 

OLS regression or Theil-Sen are superior in any case. 

Quarter-Intersect 

The quarter-intersect celeration line is calculated as follows: 

1. A starting date and ending date are determined. 

2. The distance between the starting and ending date is divided in two halves of the same 

amount of calendar time. 

3. If an observation falls exactly between the starting and ending dates, it is ignored. 

4. In each of the halves: 

a. The median y-value is determined using all the observations that fell within that 

half. 

b. An x-value is calculated as the exact calendar time middle of that half. 

5. In each half, the calculated x-value and median y-value are combined to form a kind of 

“median point”. 

6. The celeration is defined by the slope of the line that passes through the two points. 

7. The y-intersect is the y-value where the line from Step #6 passes through the y-axis. 

The quarter-intersect method has all the disadvantages of the split-middle method, plus these: 

• Changing the starting and/or ending date typically changes the celeration value even 

though all the observations are the same as before. 

• There can be a disproportionate number of observations on one side of the celeration line. 

• The two halves created in Step #2 can have a different number of observations than one 

another.  This can result in just a few points having oversized weight in the calculation of 

the celeration line. 

  



Appendix B 

Celeration Line Diagnostics 

PT Tracker has two diagnostic screens for verifying the results of the celeration line calculations.  

To use these screens, select the Celeration line diagnostics menu option on the Tools menu.  

This brings us a list of all valid celeration lines on the current chart.  Choose a celeration line to 

display the Celeration Line Diagnostics screen.  If the chart only has one valid celeration line 

annotation, you won’t be offered a choice; the diagnostics for that celeration line annotation will 

be displayed as soon as the Celeration line diagnostics menu option is selected. 

The other diagnostic screen is the Theil-Sen Diagnostics screen.  You display it by clicking the 

View Slopes button on the Celeration Line Diagnostics screen when it is showing diagnostics for 

a Theil-Sen celeration line. 

Celeration Line Diagnostics Screen 

 



The contents of the Celeration Line Diagnostics screen depend on which calculation method was 

used.  The following fields appear for all calculation methods: 

• Which data: This box indicates whether the data is for the count celeration line or the 

errors celeration line.  If both were calculated, you can click on one to display its 

diagnostic information. 

• Calculation Method: Theil-Sen, Regression, Split-Middle or Quarter-Intersect. 

• Start/End Dates: The start and end dates that define which observations were used to 

calculate the celeration line. 

• Observations: The number of observations within the specified dates. 

o For split-middle and quarter-intersect, a second number is displayed.  It is the 

number of observations that were used in the celeration calculation.  For example, 

this value would not include the middle date.  Also, if one or more dates had 

multiple observations, each such date would only be counted once in this value. 

o The Theil-Sen and OLS regression methods do not show that second value 

because they operate on all observations directly. 

• Middle Dates: 

o Theil-Sen: not applicable 

o Regression: not applicable 

o Split-middle and quarter-intersect: Two values: 

▪ First value: Last date in the first set of observations 

▪ Second value: First date in the second set of observations 

• Y-Int/Log10(Y-Int): Two values: 

o First value: The y-intercept in counts per time unit or errors per time unit. 

o Second value: Log10 of the first value. 

• Celeration/Slope: Two values: 

o First value: The celeration 

o Second value: The slope in log space 

• Y<CL / Y=CL / Y>CL: Three values.  The sum of the three numbers should be equal to 

the number of observations. 

o First value: Number of observations that are below the celeration line 

o Second value: Number of observations that are on the celeration line 

o Third value: Number of observations that are above the celeration line 

Theil-Sen: On the Celeration Line Diagnostics screen for Theil-Sen, you will see these two 

fields: 

▪ Slopes Calculated: The number of slopes calculated in order to find the median slope. 

▪ View Slopes (button): Click this button to bring up the Theil-Sen Diagnostics screen. 

Split-middle and quarter-intersect: On the Celeration Line Diagnostics screen for split-middle 

and quarter-intersect, you will see these two fields: 

▪ Half median offsets: Two values, one for each of the two sets of observations.  These are 

the day offsets (from day 0) for the two points that are used to calculate the celeration. 

o Split-middle: The two values represent offsets to the day numbers of the median 

observation dates within each set. 



o Quarter-intersect: The two values are offsets to the x-values that are 25% and 

75% of the distance from the starting date to the ending date.  They will add up to 

one less than the total number of calendar days in the date range of the celeration 

line. 

▪ Median Y (half1/half2): Four values:  The first two are log10 of the median y-values 

calculated for each set.  The second two are the actual median y-values. 

Split-middle: On the Celeration Line Diagnostics screen for split-middle, you also will see these 

two fields: 

▪ Pre-adjust y-intercept: Two values, each representing the y-intercept of the initial 

celeration line calculation (before finding the y-intercept that equalizes the number of 

observations on each side of the celeration line): 

o First value: Log10 of the pre-adjustment y-intercept 

o Second value: Pre-adjustment y-value 

▪ Pre-adjust balance: This value is calculated using the pre-adjust y-intercept.  It is the 

difference between the number of observations that are above the celeration line and the 

number of observations that are below the celeration line.  If it is zero, PT Tracker did not 

need to adjust the y-intercept. 

Regression: There are no additional diagnostic fields when the OLS regression method is used 

to calculate the celeration line. 

The table on the Celeration Line Diagnostics screen has one row for each observation within the 

domain of the celeration line.  The table has these columns: 

▪ DayNo: Day offset from the start date of the celeration line.  The start date is day 0. 

▪ Date: Date of the observation. 

▪ Duration: Duration of the observation. 

▪ Count: Count of the observation. 

▪ NumErrors: Number of errors observed. 

▪ Y-Value: The y-value that appears on the chart.  It is either count per time unit or number 

of errors per time unit, depending on which set of data is being displayed. 

▪ Log10(y): Log10 of Y-Value.  If Y-Value is zero, this column will have 

log10(0.5/duration), which is the input to the celeration line calculation. 

▪ Eighth column: The column header of the eighth column depends on which calculation 

method was used: 

o Raw Intc: The y-intercept calculated using the calculated Theil-Sen slope and the 

y-value for this observation.  (The median of all values in this column will be the 

y-intercept of the celeration line.) 

o Input: The y-value that is used as input to the celeration calculation for split-

middle and quarter-intersect. 

▪ For dates with more than one observation, the first such date will show the 

median observation for all such dates.  The field will be blank in the other 

rows. 

▪ If a date was ignored in the celeration calculation because it fell exactly in 

the middle of the two sets of observations, this field will say, “Mid”. 

o Unused: This column is empty for OLS regression. 

▪ Cel Line: Log10 of the celeration line value for the date of that observation. 



▪ Diff: The difference between Log10(y) and Cel Line.  If the two values are equal, two 

dashes (“--") will be displayed.  Sometimes the difference between the two values will be 

so small that the value will appear as either 0.000 or -0.000, which means that the 

difference was very small, but still either positive or negative. 

Theil-Sen Diagnostics 

You can display the Theil-Sen Diagnostics screen by clicking on the View Slopes button of the 

Celeration Line Diagnostics screen.  The screen consists of a table with one row for each slope 

calculated in the Theil-Sen celeration calculation.  The rows are sorted by slope, lowest to 

highest.  The columns are as follows: 

▪ #: Row number. 

▪ Day1: Day number of the first point used in the slope calculation. 

▪ Y1: Log10 of the y-value of the first point used in the slope calculation. 

▪ Day2: Day number of the second point used in the slope calculation. 

▪ Y2: Log10 of the y-value of the second point used in the slope calculation. 

▪ Slope: The slope calculated using the two points (Day1, Y1) and (Day2, Y2). 

The Theil-Sen slope will be the middle slope in this list or will be the average of the two middle 

slopes if the number of slopes is even. 



Appendix C 

Import File Specification 

Import files are formatted as CSV (comma-separated values) files.  They are human readable and 

can be created using a program such as Excel or the Windows program Notepad.  Each line (i.e, 

record) in the file consists of one or more fields, with each field separated by a comma.  

Traditionally, the file names of CSV files end with the .csv extension, but that is not a 

requirement in PT Tracker. 

This appendix describes the record formats of PT Tracker import files. There are two types of 

records: timing and control. Control records are not mandatory but can be used to tell PT Tracker 

how to import, save and display the timings.  If control records are not included in an import file, 

defaults will be used.  The defaults can be overridden via the Settings / Import menu. 

Important note regarding Excel: To create a CSV file in Excel, you mustn’t insert the commas 

between fields. Excel does that for you when you save the file. You should place each field in a 

separate column, then save the data via the Save As option on the File menu. Excel will then give 

you a dropdown box to choose the file type. The dropdown box has several types of CSV files. 

You should use the one that says, “CSV (Comma delimited) (*.csv). Do not use the one that 

says, “CSV UTF-8 (Comma delimited) (*.csv)”; it will not work! 

Timing Records 

Every timing occupies one record. By default, timing records contain the following fields in the 

order in which they appear below.  However, the order can be changed using the #FIELDS 

control record. 

• Date: Date of the test 

• Time 

• Duration: Duration of the test 

• Count: Number of correct responses counted 

• NumErrors: Number of errors counted 

Here is an example of a timing record (spaces before and after the commas are optional and are 

ignored): 

8/5/24, 11:14, 1.0, 10, 1 

Here is a detailed description of the fields and their formats: 

Date: The default format for dates is m/d/y, where y must have either two or four digits. If it has 

two digits, it is assumed to be relative to the year 2000. Other date formats are available. You 

can override the default format either in the Settings menu (Settings / Import / Import File 

Processing) or using the #DATE_FORMAT control record.  The possible date formats are 

described in Appendix E. 

Time: The time field can either be H:MM or H:MM:SS. Where H is a one- or two-digit hour 

from 0 to 23; MM and SS are two-digit numbers from 0 to 59.  The time field is typically the 



time at which the timing was performed, but it doesn’t affect how the timings are displayed 

because all timings for a given day will appear in the same spot in the chart. 

Important: When there are multiple timings on the same day, every timing must have a different 

Time field. 

Duration: The format of the duration field depends on the time units selected for the y-axis. By 

default, duration is measured in minutes, but that default can be changed via the Settings / 

Import / Default Skill for Imports menu item. The time units for the current import file can be 

modified using the #DURATION control record.  See Duration for a detailed description of the 

allowable formats for duration.  An error occurs if a timing record contains a duration that is 

greater than the value specified in the #MAX_DURATION control record. 

Count: An integer that is 0 or greater. 

NumErrors: An integer that is 0 or greater. 

Control Records 

The first field of a control record contains a keyword, such as #DURATION. The first character 

of all keywords is the pound sign (#). Control records are always optional. If a particular control 

record isn’t specified in the import file, a default value is used.  The defaults can be changed via 

the Settings / Import menu. 

If you initiate the import process with the menu selection Tools / Import timings, the Import-File 

Post Processing Parameters screen will be displayed, giving you one last opportunity to change 

most aspects of how the imported data will be processed (but not the date format, the fields in a 

timing record, or the Sort Timings setting). 

If you initiate the import process with the Tools / Import timings – quick menu selection, the 

Import-File Post Processing Parameters screen will not be displayed. In that case, PT Tracker 

will only use the default values from the Settings menu, as overridden by control records in the 

import file. 

In addition to the keyword, every control record has additional fields, as described in the table 

below. In the table, the * column indicates whether that control record must appear before any 

timing records: 

  



 

Control record keyword & format 

(Capitalization not required) 

 

* Description Examples 

#CHART_TITLE, <title> N <title>: Characters to appear at the top of the chart, just to the 

left of the name of the skill. If blank, the skill name is 

displayed within parentheses. 

 

#CHART_TITLE, Type 

#Chart_title,  

#COMMENT, … N Specifies any kind of information. The information is not 

used for anything and is never saved to the PT Tracker 

database. 

• …: Zero or more fields with virtually anything you 

want. 

 

#COMMENT 

#COMMENT, 

#COMMENT, Import file created 9/23/24 

#DATE_FORMAT, <fmt> Y Determines the format for the Date field in the timing 

records. 

• <fmt>: One of the date formats in Appendix E. 

 

#DATE_FORMAT, D/M/Y 

#Date_format, D-M-Y 

#DAYS, <num> N The number of days to display on the chart. 

• <num>: An integer from 70 to 210. Must be a 

multiple of 7. 

 

#DAYS, 140 

#Days, 210 

#DURATION, <units>, <max> Y Specifies the units in which the Duration field is measured. 

• <units>: Can be minute, hour, or day. 

• <Max>: Maximum value allowed in the Duration 

field of any timing record. The format of this value is 

the same as the format for durations (see Duration). 

 

#DURATION, hour, 12:30 

#Duration, minute, 30 

#Duration, day, 1 

  



#FIELDS, <fld>, <fld>, etc Y Specifies a list of fields to appear in every timing record. You 

can use the #FIELDS control record to change the order of 

the fields and even omit certain optional fields. The possible 

values for <fld> are: 

• DATE: mandatory 

• TIME: optional. Auto-generated if omitted, because 

every timing needs a Time field, but they don’t affect 

the chart. 

• DURATION: mandatory 

• COUNT: mandatory 

• NUMERRORS: optional. Set to 0 if omitted. 

• NA: optional. This field is used to indicate that the 

corresponding value in the timing records should be 

ignored. 

• If a field is blank, it is treated as if it were NA. 

 

#Fields, date, time, duration, count, numerrors 

#FIELDS, date, duration, count 

#FIELDS, date, na, duration, na, count 

#Fields, date, , duration, , count 

#REPLACE, <flag> N This control record only affects imports when the specified 

student and skill already exist in PT Tracker. Values of 

<flag>: 

• Y: all existing timings are replaced with the imported 

timings. Note that if the skill has annotations, the 

annotations are not replaced. They will still exist 

and may not be appropriate for the new data. 

• N: the existing timings are kept and the imported 

timings are added to the list of existing timings. 

 

#REPLACE, y 

#Replace, N 

#SAVE, <flag> N If you want to save the imported data to the PT Tracker 

database, set <flag> to Y. If you set <flag> to N, you will be 

able to view the imported data in a chart, but it won’t be 

saved to the database. 

 

Note that, if not saving to the database, you will still be 

able to add/delete timings, add/delete annotations and 

even add new skills. However, none of that will be 

saved to the database. 

#SAVE, Y 

#Save, n 



 

Also, if the imported data is not saved to the database 

and the imported student already exists with other skills, 

those skills will not be visible until you use the File / 

Close menu to close the student and reload it from the 

database. 
 

#SKILL_NAME, <name> Y <name> is the name of the skill, which is displayed at the top 

of the chart. 

#SKILL_NAME, Addition Facts 

#Skill_name, Spanish verbs 

 

#SORT, <flag> Y If <flag> is Y, the timings in the import file do not have to be 

in chronological order. They will be sorted after the import is 

finished. If <flag> is N, the timings in the import file must be 

in ascending chronological order or an error will occur. 

 

 

#SORT, Y 

#SORT, n 

#STUDENT, <f>, <l>, <id> Y Student identification information. 

• <f>: First name 

• <l>: Last name 

• <id>: ID 

 

Any of these fields can be left blank. If <f> or <l> are left 

empty and a “quick” import is performed, PT Tracker will 

assign dummy values to the empty fields. 

 

#STUDENT, Jack,, 

#Student, Olivia, Rodriguez, 23 

#Student, Stan, TheMan, 

#YAXIS_LIMITS, <l>, <u> N Specifies the range of the y-axis. The values are expressed as 

integer powers of 10. For example, a limit of 3 means 1,000. 

• <l>: Lower limit 

• <u>: Upper limit 

 

#YAXIS_LIMITS, -3, 3 

#yaxis_limits, -1, 5 

 

 



Here’s an example import file that includes all possible control records. 

#COMMENT,Example import file 

#STUDENT,ESL,Class, 

#SORT,N 

#SAVE,N 

#REPLACE,Y 

#FIELDS,Date, Time, Duration, Count, NumErrors 

#DATE_FORMAT,M/D/Y 

#SKILL_NAME,Cook - present tense 

#YAXIS_LIMITS,-1,3 

#DAYS,105 

#DURATION,MINUTE,1440.0 

#CHART_TITLE,Skill: 

10/28/2021,14:03:18,3.84,17,4 

11/1/2021,14:03:04,3.15,17,4 

11/2/2021,14:02:21,3.84,17,5 

11/4/2021,13:53:17,3.16,17,3 

11/18/2021,14:04:38,3.34,17,4 

11/30/2021,13:58:10,2.0,12,0 

12/1/2021,13:51:28,2.5,15,1 

12/1/2021,13:55:00,2.5,14,3 

12/2/2021,13:44:26,2.5,17,1 

12/3/2021,14:03:51,3.0,16,4 

12/6/2021,13:54:15,3.0,17,4 

 

 

 

  



Appendix D 

Export File Specification 

In Version 6.0, the export capability is very rudimentary. More options may be added in a later 

version if there is demand for it. 

To export timings, first load in a student and skill using the File menu (or by importing).  Then 

select Export timings for current student on the Tools menu.  The timings of the currently 

displayed student and skill will be exported to a file created in the export directory. The file 

name is generated from the student and skill as follows: 

 <first_name>_<last_name>_<ID>_<modified_skill_name>.csv 

The skill name is modified as follows: all letters, numbers and blanks remain as is, but other 

characters in the skill name are changed to dashes.  For example, assume the currently displayed 

student and skill have these values: 

 First name: Albert 

 Last name: Smith 

 ID: 3 

 Skill name: letters/symbols 

The file name would be: Albert_Smith_3_letters-symbols.csv. 

The export directory is set via the Settings / Import / Export directory menu selection. 

Export files use the exact same format as import files so they can be re-imported at a later date or 

on another computer.  The control records are chosen as follows: 

• #SORT: Always N, because the timing records are exported in chronological order. 

 

• #SAVE: Always N. That way it takes a conscious decision to save the timings if the 

export file is later used as an import file. 

 

• #REPLACE: Always Y. 

 

• #FIELDS: The current PT Tracker default, as established in the Settings menu (Settings / 

Import / Import file processing). That setting determines which timing fields will be 

exported, and in which order they will appear on each timing record. 

 

• #DATE_FORMAT: The current PT Tracker default, as established in the Settings menu 

(Settings / Import / Import file processing). The date field of timing records will be 

written using that format. 

 

• Others: Values for the currently displayed student and skill are used. 

 



Appendix E 

Date Formats for Import/Export 

These date formats are available for use in timing records of import and export files.  When 

importing, there are two ways you can change the date format (when exporting, only the first 

method is available for specifying a format to use in the export): 

• Via this menu option: Settings / Import / Import file processing 

• In the import file itself, using a #DATE_FORMAT control record 

When PT Tracker is installed, the default date format for import and export files is M/D/Y. That 

can be changed using the Settings / Import / Import file processing menu selection. 

In the following list, these codes are used: 

• M: A one- or two-digit month from 1 to 12. 

• D: A one- or two-digit day of month from 1 to the number of days in the month. 

• Y: A two- or four-digit year. If a two-digit year is in a timing record, it is assumed to be 

relative to the year 2000. 

• yyyymmdd: An eight-digit date with four digits for the year, two digits for the month and 

two digits for the day of month.  For example: 20210123 

• Anything else: If a date format contains any other character, such as “.” or “/” or “ “, it 

must appear exactly as is in the date fields of timing records. 

For example, with the format M/D/Y, the following dates are acceptable: 

• 1/1/23 

• 01/01/23 

• 12/18/2024 

However, this would not be acceptable: 1 / 1 / 23 (because M/D/Y doesn’t contain spaces). 

Possible formats: 

• M/D/Y 

• Y-M-D 

• Y/M/D 

• Y.M.D 

• Y.M.D. 

• Y. M. D. 

• D/M/Y 

• D-M-Y 

• D.M.Y 

• D.M.Y. 

• D. M. Y 

• D. M. Y. 

• D/M Y 

• yyyymmdd 
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